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Brevets et marques de commerce
La technologie Simple Plex de ProteinSimple est couverte par des brevets délivrés et en
instance aux États-Unis et dans d’autres pays. Pour plus d’informations, veuillez consulter  :
bio-techne.com/support/instrument-support/intellectual-property

ProteinSimple, le logo ProteinSimple, Simple Plex et Ella sont des marques commerciales ou des marques 
déposées de ProteinSimple. D’autres marques apparaissant dans ces documents sont des marques de leurs 
détenteurs respectifs.

Avis de propriété intellectuelle
Ce manuel est couvert par les lois américaines et internationales sur les droits d’auteur. Aucune partie de ce 
manuel ne peut être reproduite, modifiée ou transmise en totalité ou en partie sous quelque forme ou par quelque
moyen que ce soit, électronique ou mécanique, y compris la photocopie, l’enregistrement ou tout système de 
stockage et de récupération d’informations, sans l’autorisation écrite de ProteinSimple. ProteinSimple autorise
par les présentes ses clients qui ont acheté Ella à effectuer un nombre limité de photocopies ou de copies 
électroniques de ce manuel sans modifications, pour leur usage personnel, à condition que cet usage soit limité
à  l’installation ou au fonctionnement d’Ella.

Le logiciel Simple Plex est soumis aux licences énoncées dans les conditions générales standard de ProteinSimple.

mailto:support@bio-techne.com
http://bio-techne.com/support/instrument-support/intellectual-property
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Clause de non-responsabilité d’Ella
Sauf disposition expresse dans tout contrat ou devis de licence logicielle ProteinSimple, les produits vendus et les 
services fournis par ProteinSimple sont fournis « tels quels » et « tels que disponibles » sans garantie d’aucune 
sorte. ProteinSimple et ses fournisseurs ne garantissent pas la sécurité, la confidentialité ou l’exactitude des 
données fournies via les produits ou services, et vous acceptez que l’utilisation de ces données par vous est 
à vos risques et périls. Dans toute la mesure autorisée par la loi applicable, ProteinSimple et ses fournisseurs 
déclinent toute garantie, expresse, implicite ou légale, y compris, sans s’y limiter, toute garantie de qualité 
marchande, de titre, d’absence de contrefaçon ou d’adéquation à un usage particulier.

Champ d’application
Pour le bon fonctionnement du système et/ou de toutes ses pièces, les instructions de ce manuel doivent être 
strictement et explicitement suivies par du personnel expérimenté. L’intégralité du contenu de ce guide doit 
être lue et comprise avant d’utiliser le système ou toute partie de celui-ci. Le fait de ne pas lire, comprendre et 
respecter entièrement tout le contenu de ce guide avant d’utiliser le système ou ses pièces peut endommager 
l’équipement ou ses pièces et blesser toute personne qui les utilise.

But prévu
Le but prévu de l’instrument Ella est le suivant :

L’instrument Ella est un instrument non automatisé destiné à un usage diagnostic in vitro avec un test Ella pris 
en charge pour effectuer des tests immunologiques. L’instrument Ella séquence le traitement des échantillons, 
des réactifs et des tampons de lavage, et mesure et trie les signaux de fluorescence à l’aide d’un kit de test 
Ella pris en charge. L’instrument Ella est destiné à être utilisé par du personnel de laboratoire formé.

L’instrument Ella doit être utilisé dans des établissements de soins de santé professionnels (par ex., laboratoires 
cliniques, hôpitaux, cliniques). Le système Ella n’est pas destiné à être utilisé dans le cadre de soins prodigués 
au chevet du patient, ni à des fins d’autotest. Une mauvaise utilisation raisonnablement prévisible du produit 
comprend les éléments suivants. 1. Utilisation par des utilisateurs non formés 2. Utilisation avec des cartouches 
non prises en charge.

Principe du test
L’instrument Ella utilise un principe de test d’immunodosage en sandwich impliquant les étapes suivantes :

Tout d’abord, l’antigène cible est capturé à l’aide d’un réacteur nanométrique en verre en phase solide recouvert 
d’un anticorps de capture spécifique à l’antigène. L’échantillon est analysé à travers la cartouche pour fixer 
l’antigène cible à l’anticorps de capture. Un anticorps de détection qui se fixe à l’antigène est conjugué à un 
marquer fluorescent et introduit, formant ainsi un complexe « sandwich ». Après avoir éliminé les substances 
non liées, l’instrument lit la cartouche et indique les unités relatives de fluorescence. L’intensité du signal est 
directement proportionnelle à la quantité d’antigène présente dans l’échantillon. En comparant le signal obtenu de 
l’échantillon avec une courbe étalon générée à partir de concentrations connues de l’antigène, la concentration 
de l’antigène dans l’échantillon peut être déterminée. Ce principe permet une quantification hautement spécifique 
et sensible des antigènes dans divers échantillons.

Avertissement et risque résiduel
Aucune identifiée.
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TA B L E AU  //   1

Descriptions des étiquettes et des symboles

Symbole Description

MISE EN GARDE 
Se reporter à la documentation jointe

Marque d’approbation NRTL 
Approbation de sécurité électrique selon UL61010-1 :2012 ; EN61010-1 :2010 ;  
CAN/CSA C22.2 61010-1 :2012

L’assurance du fabricant que le produit répond aux exigences essentielles de toutes les directives 
européennes pertinentes.

Symbole DEEE 
Collecte séparée des équipements électriques et électroniques.

Fabricant 
Indique le fabricant du dispositif médical, tel que défini dans l’IVDR (2017/746).

Dispositif médical de diagnostic in vitro 
Indique un dispositif médical destiné à être utilisé comme dispositif médical de diagnostic in vitro.

Numéro de catalogue 
Indique le numéro de référence du fabricant afin que le dispositif médical puisse être identifié.

Identifiant unique du dispositif 
Un code numérique ou alphanumérique unique qui facilite le suivi et l’identification de l’appareil
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Chapitre 1

Découvrir Ella

Présentation du système
Ella™ est un système entièrement automatisé basé sur des cartouches qui permet aux chercheurs de mesurer 
des biomarqueurs dans plusieurs types d’échantillons. Ella, ainsi que la technologie microfluidique (cartouches 
Simple Plex™), permettent de mesurer un seul analyte, de mesurer plusieurs analytes en parallèle (multi-analytes) 
et également de réaliser des mesures multiplexes. Les chercheurs peuvent également configurer les cartouches 
Simple Plex pour qu’elles soient adaptées à leurs propres recherches. 

Avec Ella, vous pouvez : 

•	 Exécuter automatiquement un protocole de dosage immunologique 

•	 Acquérir et traiter automatiquement les données 

•	 Afficher et analyser les données de fluorescence et de concentration par analyte et par échantillon 

•	 Extraire et enregistrer les informations de fluorescence et de concentration pour une analyse spécifique 
à l’application 

ATTENTION : Le système Ella n’est pas destiné à être utilisé dans le cadre de soins prodigués au chevet 
du patient, ni à des fins d’autotest.

Spécifications
Cette section décrit les spécifications d’Ella, notamment les conditions environnementales, les caractéristiques 
électriques, les conditions physiques, la classification laser et la fusion externe. 

TA B L E AU  //   02

Spécifications de l’instrument

Conditions 
environnementales

Réservé à un usage à l’intérieur
Altitude jusqu’à 2 000 m (6 500 pi) 
Température : 18 °C à 30 °C (65 °F à 86 °F) 
Humidité : 15 à 80 % HR, inclus, sans condensation

Conditions de 
stockage et de 
transport

Température : -18 °C à 50 °C (0,4 °F à 122 °F)
Humidité : HR ≤ 85 % sans condensation 

Caractéristiques 
physiques

Dimensions globales : 37 cm (l) x 54 cm (p) x 26 cm (h)
                                      14,6 po (l) x 21,3 po (p) x 10,2 po (h) 
Poids : 18,2 kg (40,1 livres)

Fusible externe Fusible principal (entrée de l’appareil) : 4 A, 250 V ; IEC 60127 classé T4AL 250 V

Caractéristiques 
électriques

100-240 V(CA), 300 VA, 45/65 Hz, Catégorie d’installation de Classe I (surtension) II 
REMARQUE : Les valeurs électriques indiquées sont nominales

Caractéristiques des 
tests électriques

Schéma CB : IEC 61010-1:2010

Programme « CUE » de TÜV SÜD :
CAN/CSA-C22.2 N° 61010-1:2012
UL 61010-1:2012/R:2019-07
EN 61010-1:2012/R:2019-07
EN 60825-1:2014

Produit laser de classe 1 conforme aux normes IEC 60825-1:2014 et EN 60825-1:2014

Conforme aux normes de performance de la FDA pour les produits laser 21 CFR 1040.10 et 
1040.11, à l’exception des dérogations prévues par l’avis n° 50 sur les lasers, daté du 24 juin 2007.

0 6W-DOC-0025 Rev. B Sommaire



ATTENTION : Ne pas retirer le couvercle principal d’Ella ; il n’y a aucun composant interne réparable par 
l’utilisateur et vous pouvez être exposé à une haute tension.

ATTENTION : L’utilisation de contrôles, réglages ou procédures autres que ceux spécifiés dans le présent 
document peut entraîner une exposition dangereuse à la lumière laser.

Mises en garde et avertissements
Les sections suivantes décrivent les précautions de sécurité que vous devez observer lorsque vous utilisez Ella.

Il s’agit notamment des précautions pour :

•	 Sécurité générale

•	 Sécurité électrique

•	 Sécurité de la lumière laser

Précautions générales de sécurité
ATTENTION : L’opérateur d’Ella doit être formé par du personnel qualifié au fonctionnement correct de 
l’instrument et être conscient des problèmes de sécurité 

Précautions de sécurité électrique
Cette section décrit les précautions de sécurité électrique pour les connexions et les fusibles électriques d’Ella, 
ainsi que les risques de haute tension.

Connexions électriques
Brancher Ella dans un circuit mis à la terre capable de fournir au moins :

•	 15 A pour une source d’alimentation de 100 à 120 V

•	 12 A pour une source d’alimentation de 200 à 240 V. Consulter l’étiquette du fabricant au dos d’Ella pour plus 
d’informations.

Fusible
Le porte-fusibles d’entrée principal se trouve sur le côté droit de l’arrière d’Ella et contient un fusible à fusion 
lente de 4A, 250V. Le porte-fusibles est conçu pour accueillir un fusible de 5 mm x 20 mm. Les caractéristiques 
techniques des fusibles de rechange doivent être conformes à la norme IEC 60127 et être classées T4AL 250V.

ATTENTION : Avant de remplacer le fusible, éteignez Ella et débranchez le cordon d’alimentation. Si un 
fusible doit souvent être remplacé, Ella peut avoir un problème électrique. Ne pas utiliser Ella. Vous pourriez 
vous exposer à un choc électrique. Contacter l’assistance technique de Bio-Techne pour obtenir de l’aide.

Risque et précautions de tension élevée
L’ordinateur et le moniteur contiennent des composants électroniques à haute tension. Consulter les précautions 
relatives à l’ordinateur et au moniteur avant d’ouvrir l’ordinateur ou le moniteur.

Précautions de sécurité relatives à la lumière laser

Ella est un instrument laser de classe 1 qui abrite un laser de classe 3B fonctionnant à une longueur d’onde de 
640 nm. En vertu des procédures d’utilisation spécifiées, Ella ne permet pas à l’opérateur d’être exposé à la 
lumière laser. La conception laser du système Ella est conforme à la norme  IEC (EN) 60625-1-2014.

07W-DOC-0025 Rev. B Sommaire



ATTENTION : Ne pas tenter d’accéder à l’intérieur d’Ella par une ouverture quelconque. L’exposition à 
la lumière laser peut provoquer des blessures. Par exemple, regarder directement la lumière laser peut 
entraîner une cécité.

ATTENTION : L’utilisation de contrôles, réglages ou procédures autres que ceux spécifiés dans le présent 
document peut entraîner une exposition dangereuse aux rayonnements.

Respecter les précautions suivantes :

•	 Ne pas retirer le couvercle principal d’Ella. Aucun composant interne n’est réparable par l’utilisateur et 
vous pouvez être exposé à la lumière laser.

•	 Ne pas continuer à utiliser Ella si le couvercle principal ou le couvercle de la cartouche est endommagé et n’est 
plus étanche à la lumière. Contacter immédiatement l’assistance technique de Bio-Techne pour organiser la 
réparation.

Signalement des événements indésirables
Si vous devez signaler un incident grave survenu avec ce dispositif médical, vous devez le faire en contactant 
le site de fabrication (voir la rubrique « Contacter le fabricant ») ou l’autorité nationale compétente dans laquelle 
l’utilisateur et le patient sont établis. 

Qualifications de l’utilisateur
Le personnel qui utilise, entretient ou nettoie le système Ella doit être formé aux pratiques de sécurité de 
laboratoire standard et doit suivre ces pratiques lors de la manipulation de l’instrument, être pleinement qualifié et 
formé à l’utilisation du système Ella, avoir lu et entièrement compris les instructions de ce manuel d’utilisation et 
se familiariser avec les réglementations et directives de sécurité applicables à l’environnement d’utilisation.

Installation d’Ella
Ella nécessite une qualification d’installation et de fonctionnement appropriée, réalisée par un employé 
Bio‑Techne formé. Ella n’est pas prête à l’emploi avant la réception du formulaire signé par un employé de 
Bio‑Techne attestant de la réussite de la procédure IQ OQ.

Déplacer Ella
Ella est un instrument optique sensible qui peut être endommagé en cas de déplacement incorrect. Toute 
chute risque d’endommager l’instrument. Toujours mettre Ella hors tension avant de la déplacer. Consulter les 
instructions « Préparation d’Ella pour l’expédition » à la page 22 pour obtenir des conseils sur la préparation 
d’Ella pour un déplacement.

ATTENTION : Ce produit nécessite un système de levage à deux personnes. Un soulèvement de charges 
lourdes peut provoquer des blessures. Utiliser des techniques de levage appropriées.

ATTENTION : Ne placez pas Ella à proximité d’un appareil susceptible d’émettre des vibrations 
importantes (par exemple, un vortexeur), car cela pourrait interférer avec les mesures.

Mettre au rebut conformément aux réglementations locales, régionales, nationales, territoriales, 
provinciales et internationales. Consultez les fiches de données de sécurité (FDS) pour déterminer la mise 
au rebut sûre du matériel pour votre région.

Mise au rebut d’Ella
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Interconnexions : Ella vers un ordinateur
REMARQUE : Un seul instrument Ella peut être connecté et contrôlé par PC. Plusieurs instruments ne peuvent pas 
être connectés au même PC.

1.	 Câble d’alimentation secteur 
Il est utilisé pour alimenter Ella en courant alternatif. Le câble d’alimentation secteur doit comporter un 
connecteur femelle IEC 320 à une extrémité (connexion Ella) et une fiche mâle spécifique au pays à l’autre 
extrémité. Les câbles d’alimentation doivent être homologués UL et certifiés CSA avec un courant nominal 
conforme aux spécifications électriques d’Ella.

2.	Câble Ethernet (noir) 
Il s’agit de la communication avec la caméra à haute vitesse à l’intérieur de l’instrument.

3.	Câble USB 
Il s’agit de la communication avec toutes les autres fonctionnalités de l’instrument.

Interconnexions du système Ella
La Figure 2 est une vue d’ensemble des interconnexions entre Ella, le PC, le moniteur, le clavier et le lecteur de 
codes-barres. Reportez-vous aux instructions de configuration spécifiques de votre Ella et de votre PC.

F I G U R E  //   1

Connexions Ella

F I G U R E  //   2

Connexion Ella au PC et périphériques compatibles

Câble USB

Câble Ethernet

Câble d’alimentation secteur

PCElla
Câble USBCâble USB

Câble Ethernet

AC Power

Barcode Scanner

Périphériques sans fil

Alimentation secteur

09W-DOC-0025 Rev. B Sommaire



Configuration minimale requise en matière de matériel et d’informatique
Ella n’a pas besoin de réseau informatique. Il n’est pas recommandé d’établir des connexions réseau avec Ella. 
Ella fonctionne comme un système autonome et est destinée à fonctionner indépendamment d’une connexion 
réseau. Toute connexion à un réseau, intra- ou inter-réseaux, est effectuée à vos risques et périls. 

Ella ne nécessite aucun matériel supplémentaire pour fonctionner. Il n’est pas recommandé de connecter du 
matériel supplémentaire à Ella et cela se fait à vos risques et périls.

Mesures de sécurité informatique
Le client doit :

1.	 Contrôler l’accès physique à l’instrument pour empêcher tout accès non autorisé 

2.	Contrôler l’accès au port USB du dispositif uniquement sur un support amovible fiable 

Contacter le service clientèle
Pour obtenir une assistance client ou des informations de commande, contacter le service clientèle. 
Pour une assistance technique, contacter l’assistance technique.

Web 			   www.bio-techne.com/brands/proteinsimple

Service 
clientèle

Téléphone 		  1-408-510-5500 
				    1-888-607-9692 (appel gratuit, États-Unis et Canada uniquement)

E-mail : 			  orders@proteinsimple.com

Assistance 
technique

Téléphone 		  1-408-510-5500 
				    1-888-607-9692 (appel gratuit, États-Unis et Canada uniquement)

E-mail : 			  support@bio-techne.com

10W-DOC-0025 Rev. B Sommaire



Chapitre 2

Démarrer Ella

Introduction
Ella est un système entièrement automatisé basé sur des cartouches qui vous permet d’effectuer des dosages 
immunologiques multi-analytes avec la spécificité d’un test ELISA single-plex traditionnel (test immunoenzymatique).

Avec Ella, vous pouvez :

•	 Exécuter automatiquement un protocole de dosage immunologique

•	 Procéder à l’accquisition et au traitement automatiques des données d’intensité

•	 Afficher et analyser les données d’intensité et de concentration

•	 Extraire et enregistrer les informations d’intensité et de concentration pour l’analyse spécifique à l’application

Composants du système Ella
Ella se compose de cinq composants principaux :

1.	 Instrument/lecteur Ella

2.	Lecteur de code-barres

3.	Ordinateur personnel

4.	Logiciel Runner CE

5.	Cartouche de vérification (les cartouches Simple Plex sont disponibles séparément)

Ella
L’un composant principal du système Ella est un analyseur de paillasse sans fluidique intégrée, ce qui réduit 
considérablement les déchets et les besoins en maintenance préventive.

Conçu dans le but de « charger et démarrer », Ella contrôle la cartouche de test microfluidique en manipulant 
avec précision les volumes, les débits et les schémas de débit sans intervention humaine. Après la partie test 
d’une série, Ella effectue automatiquement une analyse par fluorescence, le traitement des données brutes 
et calcule les valeurs RFU (unités de fluorescence relatives) et les concentrations par analyte, par échantillon. 
Un câble d’alimentation est fourni avec l’instrument.

Lecteur de code-barres
Le système Ella comprend un lecteur de codes-barres portable à usage général capable de scanner des codes-
barres 1D et 2D dans toutes les directions. Chaque kit de cartouche expédié par Bio-Techne est étiqueté avec un 
code-barres 2D Data-Matrix qui contient toutes les données pertinentes du kit de cartouche, notamment :

•	 Informations de lot

•	 Informations sur le panel des biomarqueurs

•	 Informations de configuration des cartouches
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F I G U R E  //   3

Cartouches utilisées dans Ella.

ATTENTION : Toute configuration n’utilisant pas le logiciel Runner CE et les cartouches portant le 
marquage CE prises en charge n’est pas conforme à la configuration du système portant le marquage CE.  

Chaque série de cartouches commence par la lecture du code-barres du kit de cartouches afin de fournir à 
l’utilisateur toutes les informations importantes sur le kit de cartouches provisoires et au logiciel les données 
nécessaires pour effectuer la série de cartouches et le traitement des données brutes.

Ordinateur personnel
Un PC est inclus avec Ella pour vous permettre de contrôler le système. Un câble USB et un câble réseau sont 
fournis pour se connecter à l’Ella.

Logiciel Simple Plex 
Runner CE est un système logiciel sans interface graphique destiné à exécuter les cartouches et à intéragir avec 
une interface graphique développée par le concepteur de test. Le Runner CE est préinstallé sur le PC inclus 
avec le système Ella. Pour obtenir des informations ou de l’aide sur le développement d’une interface utilisateur 
graphique, contacter Bio-Techne. 

Cartouche de vérification
La cartouche de vérification est fournie comme référence réutilisable nécessaire pour effectuer un autotest de 
l’instrument. Voir « autotest Ella », page 21 pour plus de détails.

Cartouches et tests Simple Plex
La cartouche IVD prête à l’emploi est disponible au format multi-analytes à 32 échantillons (voir Figure 3). La 
cartouche est développée avec un panel unique à votre recherche pour vous permettre de lire le code-barres, de 
saisir vos échantillons et le tampon dans la cartouche, de placer la cartouche dans le porte-cartouche d’Ella et 
d’exécuter la cartouche. Les cartouches et les tests Simple Plex ne sont pas inclus avec le système Ella. Utiliser 
uniquement avec les cartouches et les kits de test étiquetés pour une utilisation avec l’instrument Ella. 

Chaque cartouche comporte de nombreuses entrées d’échantillon. Chaque entrée d’échantillon comporte jusqu’à 
4 canaux dédiés. Un seul canal contient trois nano-réacteurs en verre (GNR), qui sont fonctionnalisés avec des 
anticorps de capture, de sorte que trois résultats déclarables sont obtenus pour chaque analyte de l’échantillon. 
Le GNR contient le dosage immunologique et est basé sur les réactifs des R&D Systems pour garantir une haute 
qualité et une sensibilité reproductible. La collecte de GNR dans un canal donné, dans une entrée d’échantillon 
donnée, sur une cartouche donnée constitue la base de l’ensemble des mesures produites lors de l’exécution 
d’une cartouche Simple Plex.

Cartouche de 
vérification

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Cartouche de test 
et d’étalonnage

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Cartouche Simple  
Plex 32x4

32 échantillons, 4 analytes

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Démarrage et arrêt d’Ella
Suivez les procédures de cette section qui décrivent comment positionner, démarrer et arrêter Ella.

REMARQUE : Lors du positionnement d’Ella, veiller à ce que la surface arrière dispose d’un dégagement 
adéquat afin que la main de l’opérateur puisse accéder à l’interrupteur d’alimentation et au câble d’alimentation. 
L’opérateur étant face à l’avant de l’Ella, l’interrupteur d’alimentation et le câble d’alimentation se trouvent sur le 
panneau arrière, en bas à gauche.

Démarrage du système
Pour démarrer Ella :

1.	 Mettre Ella sous tension.

2.	Mettre l’ordinateur et le moniteur d’Ella sous tension.

3.	Se connecter au PC et démarrer 

4.	Après la mise sous tension d’Ella, le voyant d’état 
s’allume (Figure 4). Voir le tableau 3 pour une 
description du voyant d’état.

Mise sous tension d’Ella
Appuyer sur l’interrupteur d’alimentation situé sur le 
panneau arrière d’Ella.

Arrêt du système
Pour arrêter Ella :

1.	 Éteindre l’ordinateur d’Ella

2.	Éteindre Ella en appuyant sur l’interrupteur 
d’alimentation situé sur le panel arrière.

TA B L E AU 3.

Indications du voyant d’état Ella.
F I G U R E  //   4

Voyant d’état Ella.

Couleur de la 
lumière Statut

● Vert Ella est alimentée et prête 
à l’emploi

● Bleu Ella exécute une cartouche

● �Clignotement 
rouge

Une erreur s’est produite (Ella 
peut éventuellement émettre une 
alarme sonore)
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Chapitre 3

Exécution de cartouches Simple Plex

Introduction
La section suivante est fournie à titre d’information uniquement. Veuillez vous reporter à la fiche de spécifications 
et à la documentation du produit pour plus d’informations sur l’utilisation de votre cartouche. 

Exécution d’une cartouche
Pour analyser une cartouche, vous aurez besoin de :

•	 Vos échantillons

•	 Le kit de cartouche étiqueté par code-barres (Figure 5) qui contient :

a.	 Le tampon de lavage A

b.	Le(s) composant(s) du diluant d’échantillon

c.	 La cartouche

La séquence de série typique est :

1.	 Préparer les réactifs

2.	Préparer la cartouche

3.	Configurer et exécuter avec Ella

F I G U R E  //   5

Kit de cartouche.

Kit emballé Tampon de lavage et diluant 
d’échantillon

Cartouche dans la poche, incluant 
étiquette avec code-barres 
(entouré en rouge)

Étiquettes de code-barres
Étiquette du kit

Situé à l’extérieur du sac de la cartouche, entouré sur la Figure 5.
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Étiquette de cartouche

L’étiquette à code-barres de la cartouche (voir Figure 6) se trouve directement sur la cartouche et sert à suivre la 
cartouche jusqu’au kit. Cette étiquette à code-barres de la cartouche est utilisée pour confirmer que la cartouche 
en cours d’analyse correspond au kit. 

Les codes-barres des ID de cartouche se trouvent sur la face de la cartouche près du bord inférieur, comme 
illustré à la Figure 6.

Préparation des échantillons et des réactifs
Échantillons de plasma (EDTA ou héparine) et de sérum

Les échantillons de sérum et de plasma préparés selon le protocole recommandé sur la fiche de spécifications 
du test et ne contenant pas de particules visibles ne nécessitent pas de centrifugation supplémentaire avant 
utilisation dans un test Simple Plex.

Pour les échantillons de sérum et de plasma contenant des particules visibles, il est recommandé d’éliminer les 
particules par centrifugation et de les diluer conformément aux instructions des feuilles de spécifications du test. 
La méthode ci-dessous est conçue pour préserver l’échantillon, mais peut être ajustée selon les besoins en fonction 
de la disponibilité de l’échantillon et de la teneur en particules. La méthode ci-dessous simule la préparation de 
l’échantillon pour la dilution minimale requise (MRD) à 1:2 utilisée dans la plupart des tests Simple Plex. Pour des 
facteurs de dilution plus élevés, une dilution en série peut être nécessaire pour assurer la précision.

Centrifugation pour les échantillons de sérum et de plasma

1.	 Aliquoter 35 μL de sérum ou de plasma dans un tube de microcentrifugeuse.

2.	Centrifuger entre 8 000 et 10 000 g pendant au moins 4 minutes.

3.	Aliquoter 30 μL du diluant échantillon approprié dans un autre tube de microcentrifugeuse.

4.	Une fois la centrifugation terminée, prélever 30 μl d’échantillon en veillant à ne pas perturber le culot au fond 
du tube.

5.	Ajouter les 30 μl d’échantillon centrifugé aux 30 μl de diluant aliquoté et bien mélanger.

6.	Pipeter 50 μl de l’échantillon dilué au 1:2 dans l’entrée de la cartouche spécifiée.

Autres types de spécimen

Les dilutions optimales doivent être déterminées par l’utilisateur final.

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Codes-barres d’ID de cartouche.

Codes-barres d’ID de cartouche : Face complète de la cartouche 32×4 (gauche). La vue agrandie détaillée affiche les détails de la cartouche 
et le code-barres (droite).
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Préparer la cartouche
REMARQUE : Lors de la manipulation des cartouches, il est recommandé de porter des gants à tout moment et de 
retirer le support en plastique uniquement immédiatement pour placer la cartouche dans Ella.

Procédure

1.	 Lire le code-barres du kit à l’extérieur du sachet sous vide de la cartouche.

2.	Retirer la cartouche du sachet sous vide.

3.	Lire le code-barres de la cartouche.

4.	Pipeter les volumes dans la cartouche dans l’ordre suivant :

a.	 Tampon de lavage comme décrit sur la notice de la cartouche.

b.	Échantillon dilué correspondant à la notice de la cartouche.

5.	Décoller le revêtement protecteur par le bas de la cartouche.

6.	Placer la cartouche dans le porte-cartouche Ella. 
 
REMARQUE : Après avoir retiré le revêtement, veiller à ne pas toucher le fond de la cartouche ni la placer sur 
une surface.

7.	Fermer le clamp et le couvercle de la cartouche.

La séquence de préparation d’une cartouche est illustrée à la Figure 7.

A. Préparation de la cartouche

1.	 Lecture du code-barres.

F I G U R E  //   7

Guide visuel étape par étape pour préparer une cartouche à exécuter dans Ella.

2.	Retrait du boîtier 
de protection de la 
cartouche.

3.	Lecture du code-barres 
de la cartouche pour 
confirmation (facultatif).

4.	Chargement du tampon.

5.	Chargement de 
l’échantillon.

6.	Retrait du revêtement  
protecteur/support.
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B. Chargement de la cartouche dans l’Ella

F I G U R E  //   7

Guide visuel étape par étape pour préparer une cartouche à exécuter dans Ella (suite).

1.	 Ouverture de la porte d’Ella.

2.	Ouverture du clamp de la 
cartouche.

3.	Ouverture de la porte et du 
clamp Ella.

4.	Chargement de la cartouche 
dans Ella.

5.	Fermeture du clamp de 
la cartouche.

6.	Fermeture de la porte.

ATTENTION : Veiller à ne pas renverser de liquide dans le logement de cartouche 

Simple Plex Runner CE
Une version sans interface graphique et sans interface 
de Runner CE est disponible dans les icônes cachées 
de la barre des tâches de votre bureau (voir Figure 8). 
Elle peut être utilisée pour modifier les paramètres 
Runner, faire avancer l’étape Ella ou exporter des 
fichiers de diagnostic ou d’autres données. 

F I G U R E  //   8

Icône Simple Plex Runner CE.

Clicking Settings > Application (Cliquer sur 
Paramètres > Application) dans le menu pour afficher 
la boîte de dialogue Settings (Paramètres) comme 
illustré à la Figure 9. Un clic sur une ligne de la boîte 
de dialogue des paramètres affiche une description 
détaillée de l’élément sélectionné en bas de la boîte 
de dialogue. Ces descriptions sont fournies dans le 
tableau 4 pour référence. Si des modifications sont 
apportées, le bouton Save (Enregistrer) sera activé.

F I G U R E  //   9

Boîte de dialogue des paramètres de Simple 
Plex Runner CE.
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Renommer l’instrument Ella dans les paramètres Simple Plex Runner CE.

Cliquer sur Settings > Analyzer > Description (Paramètres > Analyseur > Description) dans le menu pour afficher 
une boîte de dialogue qui peut être utilisée pour renommer l’instrument Ella (Figure 10). Le nom de l’instrument 
défini ici est écrit dans le logiciel intégré de l’instrument et persiste même si l’ordinateur est changé. Ce nom sera 
associé à tous les fichiers .cydat produits par l’instrument.

Paramètre Description

Use21CFRPart11Mode 
(Utiliser21CFRPariet11Mode)

Détermine s’il faut ou non utiliser la prise en charge de la norme 21 CFR Partie 11 (connexions, 
pistes d’audit, acceptation des données, etc.). La prise en charge de la norme 21 CFR Partie 11 
doit être activée pour que ce paramètre prenne effet.

AutoLockInactivityMinutes 
(VerrouillageAutomatique 
InactivitéMinutes)

Détermine la durée d’une période d’inactivité avant que l’écran de l’application ne se verrouille 
automatiquement en mode 21 CFR Partie 11. Régler sur 0 pour désactiver cette fonction.

LogoutWhenDone 
(DéconnexionAprès 
Achèvement)

Lorsque cette option est True (Vraie) (par défaut), l’utilisateur actuel est déconnecté après avoir 
sélectionné Done (Terminé) dans le panneau Kit Results (Résultats du kit). Lorsque la réponse est 
False (Fausse), l’utilisateur actuel reste connecté et l’application passe au panel New Kit (Nouveau kit).

AllowOutputFilePathChange 
(AutoriserChangementChemin 
FichierSortie)

Lorsque cette option est False (Fausse), le nom et l’emplacement du fichier de résultats du kit ne 
peuvent pas être modifiés. Cela s’applique également au fichier d’exportation LIMS générique (si 
activé). Ce réglage s’applique uniquement en mode 21 CFR Partie 11.

KitResultsFileDefaultFolder 
(DossierParDéfautFichier 
RésultatsKit)

Répertoire commun dans lequel le fichier de résultats du kit (extension *.cydat) doit être généré.

AlwaysShow3DecimalsFor 
Concentration 
(ToujoursAfficher3Décimales 
PourLaConcentration)

Toujours afficher 3 décimales pour la concentration. Par défaut, le nombre de décimales 
affichées est basé sur le nombre de chiffres significatifs présents dans la mesure. Ce paramètre 
modifie également la façon dont les valeurs de concentration sont exportées.

GnrFilter (FiltreGnr)
Le filtre utilisé pour sélectionner les GNR obtenus. None (Aucun) indique que tous les GNR trouvés ont 
été sélectionnés. Le RFU (RFU) et le Concentration CV (CV de concentration) effectuent une élimination 
des valeurs aberrantes du GNR si le pourcentage de CV pour les trois GNR dépasse seuil spécifié.

GnrFilterPercentCVThreshold 
(PlusSeuilPourcentageCvFiltreGnr) Le seuil de pourcentage de CV utilisé par le GnrFilter (FiltreGnr).

UseSampleStandardDeviation 
(UtiliserÉcartTypeÉchantillon)

Préférence utilisée pour calculer le pourcentage de CV. Si cette case est cochée, l’écart-type de 
l’échantillon est utilisé. Sinon, l’écart-type de la population est utilisé (par défaut).

ResultWarning 
(AvertissementRésultat)

Ce paramètre s’applique à tous les types de cartouches, sauf 32x8 et 72x2. Détermine si un résultat 
d’analyte doit être coloré en rose clair dans la vue Results Summary (Résumé des résultats) lorsque 
le pourcentage de CV correspondant est supérieur ou égal au seuil spécifié. Si le réglage Use Filter 
(Utiliser le filtre) est sélectionné, le CV et le seuil applicables sont déterminés à partir des paramètres 
GnrFilter (FiltreGnr) et GnrFilterPercentCVThreshold (PlusSeuilPourcentageCvFiltreGnr). La valeur 
par défaut est UseFilterSetting (UtiliserRéglageDuFiltre).

ResultWarningHighCVPercent 
Threshold 
(SeuilAvertissementRésultat 
PourcentageCVÉlevé)

Le pourcentage de CV utilisé par ResultWarning (AvertissementRésultat). La valeur par défaut 
est 10.

ResultWarning2Gnrs 
(AvertissementRésultat2Gnr)

Ce paramètre s’applique uniquement au type de cartouche 32x8 et 72x2. Détermine si un 
résultat d’analyte est coloré en rose clair dans la vue Results Summary (Résumé des résultats) 
lorsque le pourcentage de CV correspondant est supérieur ou égal au seuil spécifié. La valeur 
par défaut est Off (Désactivée).

ResultWarning2GnrsHighCV 
PercentThreshold 
(SeuilAvertissementRésultat2Gnr 
PourcentageCVÉlevé)

Le pourcentage de CV utilisé par ResultWarning2Gnrs (AvertissementRésultat2Gnr). La valeur 
par défaut est 20.

TA B L E AU 4

Paramètres Runner CE.
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Paramètre Description

AutoExportKitResults 
SummaryReport 
(ExportationAutomatiqueRésultats 
KitRapportRésumé)

Détermine s’il faut exporter automatiquement un rapport résumé des résultats du kit à la fin d’une 
série et chaque fois que le fichier de résultats du kit est enregistré. L’emplacement et le nom du 
fichier seront les mêmes que ceux du fichier des résultats du kit (.cydat ou .ecydat), sauf que 
l’extension du fichier sera remplacée par .pdf

DemoModeEnable 
(ActivationModeDémo) L’application fonctionne en mode démo et ne nécessite pas de système Ella connecté.

KitRunDataRepositoryEnabled 
(ActivationKitRépertoireDonnées 
Analyse)

Détermine si le référentiel de données de série de kit (KRDR) est activé. Le KRDR inclut toutes les 
données de l’exécution diagnostiques d’un kit, ainsi qu’une sauvegarde du fichier de résultats du 
kit. Si cette option est désactivée, la récupération du fichier de résultats du kit ne sera 
pas possible.

KitRunDataRepository  
(KitRépertoire 
DonnéesAnalyse)

Répertoire racine dans lequel stocker toutes les données de la série de diagnostic pour un kit 
ainsi qu’une sauvegarde du fichier de résultats du kit. Les dossiers sont organisés par date, puis 
par ID de kit avec la durée d’exécution.

LocalKitRunDataRepository 
AutoPurgeEnabled 
(ActivationPurgeAutomatique 
RépertoireDonnéesAnalyseKitLocal)

Détermine si les anciennes données d’un référentiel local de données d’exécution de kit (KRDR) 
sont automatiquement purgées. La fonctionnalité de purge automatique n’est pas appliquée à un 
KRDR sur un lecteur ou un partage réseau

LocalKitRunDataRepository 
AutoPurgeDaysToRetain  
(JoursConservationPurge 
AutomatiqueRépertoireDonnées 
AnalyseKitLocal)

Détermine le nombre de jours de données à conserver si 
LocalKitRunDataRepositoryAutoPurgeEnabled 
(ActivationPurgeAutomatiqueRépertoireDonnéesAnalyseKitLocal) est True (Vraie). Le nombre 
par défaut de jours pour conserver les données de série de kit locales est de 90 jours.

Generate2DMeasureScanData 
(GénérerDonnées 
ScanMesure2D)

Génère des données diagnostiques supplémentaires pour les acquisitions de mesure. 
Augmentera l’espace utilisé par le référentiel de données d’analyse du kit, pouvant aller jusqu’à 
une hausse de 25 %. La valeur par défaut est True (Vraie).

AutoExportKitResultsTo 
GenericLIMSFile 
(ExportAutomatiqueRésultats 
KitVersFichierLIMSGénérique)

Détermine s’il faut ou non générer automatiquement un fichier d’exportation LIMS générique à la 
fin de la série.

GenericLIMSExportFileDefault 
Folder (DossierParDéfautFichier 
ExportLIMSGénérique)

Emplacement de référentiel par défaut dans lequel sera enregistré le fichier d’exportation LIMS 
générique généré automatiquement (*. csv). 

GenericLIMSAutoExport 
AppendSampleAggregateData  
(ExportAutomatiqueLIMSGénérique 
AjouterDonnéesAgrégées 
Échantillon)

Lorsque cette option est True (Vraie), les données agrégées de l’échantillon sont ajoutées à la fin 
du fichier d’exportation LIMS généré automatiquement.

GenericLIMSAutoExport 
ColumnsSameAsImport  
(ExportAutomatiqueLIMSGénérique 
ColonnesIdentiquesÀImport)

Détermine s’il faut ou non que le fichier d’exportation LIMS générique généré automatiquement 
utilise les mêmes colonnes que le fichier d’importation (si disponible). Sinon, le format par défaut 
est utilisé.

ShowConcentrationOutOf 
RangeIndicationForExport 
(AfficherIndicationConcentration 
HorsPlagePourExport)

Lorsque cette option est True (Vraie), les valeurs de concentration hors plages pour les 
exportations LIMS génériques sont affichées comme LLOQ ou ULOQ ajusté par le facteur de 
dilution avec un préfixe « < » ou « > » (tel que « < 2,00 » ou « > 5 000 »).  Sinon, si cette option est 
False (Fausse), les valeurs de concentration hors plages restent vides

GenericLIMSImportFileDefault 
Folder 
(DossierParDéfautFichierImport 
LIMSGénérique)

Emplacement de référentiel par défaut pour choisir le fichier d’importation LIMS générique (*.
csv).

UseGenericLIMSImportFile 
DefaultFolder 
(UtiliserDossierParDéfaut 
FichierImportLIMSGénérique)

Détermine s’il faut utiliser ou non le référentiel par défaut spécifié dans 
GenericLIMSImportFileDefault Folder (DossierParDéfautFichierImport LIMSGénérique). Si le 
référentiel par défaut n’est pas utilisé, ce sera le dernier référentiel utilisé qui sera utilisé par 
défaut.

ComPortName (NomPortCom) Port de communication vers l’instrument.

NomPortComLecteurCodeBarres Port de communication vers le lecteur de code-barres.

BeepOnRunError 
(SignalSonoreEnCasErreurAnalyse)

Indique si Ella doit émettre un bip lorsqu’une erreur survient pendant une exécution afin d’attirer 
l’attention de l’utilisateur.

RequireCartridgeBarcodeScan 
(RequiertScanCodeBarres 
Cartouche)

Nécessite la lecture du code-barres de la cartouche sur le panel New Kit (Nouveau kit).

SelfTestDataRepository 
(RépertoireDonnéesAutotest)

Répertoire racine dans lequel stocker toutes les données d’autotest. Les dossiers sont organisés 
par numéro Ella, puis par date et heure de test.

TA B L E AU 4

Paramètres Runner CE.
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Les référentiels de données
Le logiciel Simple Plex Runner CE est configuré pour stocker les données associées à chaque série de kits et 
d’autotests. Les données sont placées dans des référentiels de données organisés par date et par série.

Répertoire des données d’exécution du kit (KRDR)

•	 Permet la sauvegarde/récupération des CYDAT 
pour chaque série de kits.

•	 Fournir des données de diagnostic dans le cas peu 
probable de problèmes du système.

 Référenciel de données d’autotest (STDR)

•	 Fournit un historique récupérable de toutes les 
séries d’autotest.

•	 Fournit des données de diagnostic dans le cas peu probable de problèmes du système.

L’emplacement des référentiels peut être configuré à l’aide des paramètres de l’application Simple Plex Runner CE.

Récupération d’un CYDAT
Si le KRDR est utilisé et qu’un CYDAT a été déplacé ou perdu d’une série, il est possible de récupérer le CYDAT de ce 
kit à l’aide de l’option Recover Kit Results (Récupérer les résultats du kit) située dans le logiciel Simple Plex Runner 
CE sous File > Recover Kit Results (Fichier > Récupérer les résultats du kit). La sélection de cette option permet de 
localiser le kit CYDAT spécifié dans le référentiel et d’en faire une copie à l’emplacement de stockage souhaité.

Navigation/Récupération des autotests
En sélectionnant Self Test History (Historique des autotests) dans le logiciel Simple Plex Runner CE sous  Tools > 
Self Test History (Outils > Historique des autotests), vous pouvez afficher une liste de tous les autotests dans le 
référentiel organisés par système Ella et par date. Vous avez également la possibilité de récupérer/enregistrer un 
ou plusieurs rapports d’autotest, et les détails des résultats de tout autotest peuvent être consultés.
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Chapitre 4

Entretien d’Ella

Introduction
Ce chapitre décrit les tâches de maintenance et 
d’entretien pour Ella. Consulter le chapitre 3 pour 
accéder à Simple Plex Runner CE.

Utilisation du menu Outils de Simple Plex 
Runner CE 

Le menu Tools (Outils) (Figure 11) est utilisé pour 
déplacer l’étape XY vers des emplacements 
prédéfinis (doit être effectué avec le clamp et 
le couvercle fermés) et exporter les journaux du 
système de diagnostic vers un fichier compressé 
destiné à être utilisé par le support technique.

F I G U R E  //  11

Menu Outils de Simple Plex Runner CE

F I G U R E  //  1 2

Cartouche de vérification Ella.

Autotest Ella
La cartouche de vérification Ella permet au système d’effectuer une série de tests diagnostiques qui garantissent 
le bon fonctionnement de l’instrument. Le logiciel Runner CE prend en charge les mécanismes d’exécution d’un 
autotest, mais l’interface graphique doit être conçue par le développeur du test pour effectuer le test. Pour obtenir 
des informations ou de l’aide sur le développement d’une interface utilisateur graphique, contacter Bio-Techne. 

Les résultats seront consignés sous les fichiers journaux du système. Ces résultats fournissent des informations 
de dépannage précieuses au personnel de Bio-Techne au cas où une maintenance du système serait nécessaire. 
Par conséquent, nous vous conseillons d’utiliser la cartouche de vérification toutes les semaines pour créer un 
historique continu des performances du système.

La cartouche de vérification a été fournie dans une boîte de stockage comme illustré sur les Figures 12 A et B. 
Lors de la manipulation de la cartouche de vérification, porter des gants pour éviter de la salir. La cartouche de 
vérification comporte une surface pour sceller l’interface pneumatique d’Ella, et une surface autofluorescente 
servant de référence RFU.

ATTENTION : Ne pas utiliser une cartouche de vérification au-delà de sa date de péremption. Cette date 
est affichée sur la cartouche elle-même ou sur sa certification d’étalonnage 

A. 
Boîte de cartouche de 
vérification.

B. 
Cartouche dans la 
boîte, code-barres 
vers le haut.

Utilisation des commandes Move To (Déplacer vers) dans le menu du logiciel Simple Plex Runner CE 
Ouvrir Simple Plex Runner CE

Position de la fenêtre Objectif 
La commande Tools > Move To > Objective Window Position (Outils > Déplacer vers > Position de la fenêtre de 
l’objectif) permet de se déplacer vers la position correcte pour retirer ou installer la fenêtre de l’objectif qui est 
vissée dans la plaque chauffante. 
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ATTENTION : Ne pas utiliser le système si le câble d’alimentation est endommagé de quelque manière 
que ce soit

Position de chargement de la cartouche 
La commande Tools > Move To > Cartridge Load Position (Outils > Déplacer vers > Position de chargement de la 
cartouche) permet de revenir à la position de chargement si vous avez précédemment déplacé la fenêtre vers la position 
de l’objectif ou la position d’expédition. Elle est également prévue dans le cas très improbable où l’instrument ne ramènerait 
pas le plateau tournant à la position de chargement. Si cela se produit, contacter le service technique Bio-Techne. 

Position d’expédition 
La commande Tools > Move To > Ship Position (Outils > Déplacer vers > Position d’expédition) est fournie dans le 
cas où Ella doit être emballée pour l’expédition.

Préparation d’Ella pour l’expédition
Pour préparer Ella à l’expédition :

1.	 Fermer le clamp et le couvercle

2.	Cliquez sur Tools > Move To > Ship Position (Outils > Déplacer vers > Position d’expédition) dans le menu 
Simple Plex Runner CE.

3.	Attendez que la boîte de dialogue contextuelle Moving to shipping position (Déplacement vers la position 
d’expédition) se ferme.

4.	Arrêter Ella :

a.	 Fermer Simple Plex Runner CE en cliquant sur  File > Exit (Fichier > Quitter) dans le menu ou Close (Fermer) 
(X) dans le coin supérieur droit de la fenêtre d’application. Fermer le logiciel. Éteindre l’ordinateur d’Ella.

b.	Éteindre Ella en appuyant sur l’interrupteur d’alimentation situé sur le panel arrière.

Exportation des journaux système
Ouvrir Simple Plex Runner CE

Cliquez sur Tools > Export Diagnostic Data (Outils > Exporter les données de diagnostic) pour l’assistance technique 
pour exporter les informations de diagnostic vers un fichier compressé zip si l’assistance technique le demande.

Entretien et nettoyage
Ella nécessite une maintenance préventive annuelle effectuée par un représentant Bio-Techne. Sinon, aucun 
étalonnage par l’utilisateur n’est requis. Cela dit, il est recommandé d’effectuer des inspections périodiques du 
système. Noter tout dommage au boîtier d’Ella ou à l’isolation des câbles associés. Si les dommages sur le boîtier 
indiquent que la protection des composants électroniques contre l’humidité ou la lumière laser est compromise 
ou que cette compromission est imminente, ou si les dommages sur les câbles suggèrent que des courts-circuits 
ou des ouvertures électriques sont imminents, prenez les mesures correctives appropriées en fonction de la 
situation, pouvant aller jusqu’au retrait du produit du service jusqu’à ce que les réparations aient été effectuées. 
Contacter le service clientèle pour obtenir des informations concernant les réparations et les pièces de rechange.

Les matériaux nécessaires pour entretenir et nettoyer correctement Ella sont les suivants :

1.	 Solution d’eau de Javel domestique à 10 %

2.	Solution d’éthanol à 70 %

3.	Détergent doux

4.	Chiffons propres et non pelucheux

5.	Lingettes jetables pour objectifs (en option)
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ATTENTION : Ne pas nettoyer la surface extérieure avec de l’éthanol.

ATTENTION : Lors du nettoyage de la fenêtre 
de l’objectif

•	 Ne pas utiliser d’eau de Javel

•	 Ne pas toucher la fenêtre de l’objectif 
autrement qu’avec le chiffon non abrasif

ATTENTION : Lors du nettoyage du logement, veiller à ne pas contaminer la fenêtre de l’objectif.

Nettoyage du nid de cartouche et de la fenêtre de l’objectif
Logement de la cartouche

Si nécessaire, le logement de la cartouche d’Ella peut être nettoyé à l’aide d’une lingette non abrasive non 
pelucheuse imbibée d’éthanol à 70 %. 

Fenêtre de l’objectif

Veiller à ce que la fenêtre de l’objectif soit propre. 
Si un nettoyage est nécessaire, utiliser une lingette 
propre non abrasive non pelucheuse humectée de 
détergent doux ou d’éthanol à 70 % jusqu’à ce que la 
fenêtre soit « exempte de traces ». Il est recommandé 
d’utiliser plusieurs lingettes à usage unique pour 
s’assurer que la fenêtre de l’objectif est nettoyée 
(sans stries), voir Figure 13.

F I G U R E  //  1 3

Logement de la cartouche et fenêtre de l’objectif.

Fenêtre de  
l’objectif

Logement de  
la cartouche

Nettoyage et maintenance du filtre de ventilateur
Ella doit toujours recevoir une ventilation adéquate pour le refroidissement. Un refroidissement approprié est 
nécessaire pour qu’Ella réponde aux spécifications et pour éviter la surchauffe. La maintenance périodique des 
instruments doit inclure l’inspection et le nettoyage du filtre de ventilateur tous les six mois.

Pour nettoyer le filtre :

1.	 Retirer le protège-ventilateur et le filtre de ventilateur.

2.	Nettoyer le filtre du ventilateur à l’aide d’un aspirateur.

3.	Si nécessaire, remplacer les filtres de ventilateur usés ou endommagés (réf. 541401).

4.	Réinstaller le filtre de ventilateur et le protège-ventilateur.

Nettoyage des surfaces externes
Éteindre et débrancher Ella avant le nettoyage. Si nécessaire, essuyer uniquement les surfaces externes d’Ella 
avec un chiffon humide non abrasif qui peut être humidifié avec un détergent doux. De plus, si des accessoires, 
comme le câble USB ou le lecteur de code-barres, doivent être nettoyés, il est possible de le faire en utilisant à 
nouveau uniquement un chiffon humide non abrasif qui peut être humidifié avec un détergent doux.
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